


WILLKOMMEN IN DER FLUX COMMUNITY!

FLUX begann mit Leidenschaft fur die digitale Kreativitdt und der
Herstellung benutzerfreundlicher und erschwinglicher Tools fur
Produzenten und Designer. 2.500 Unterstltzer haben uns 2014
geholfen, 1,6 Millionen US-Dollar bei Kickstarter fir unseren
ersten modularen 3D-Drucker FLUX Delta zu sammeln. Nachdem
wir zahlreiche Anfragen von unseren Benutzern nach einem
anwenderfreundlichen Lasercutter erhalten hatten, haben wir uns
entschlossen, diese Herausforderung anzunehmen und in die
Welt der Lasertechnologie einzutauchen. In den letzten Monaten
haben wir hart fir diesen Moment gearbeitet und viel Herzblut in
die Entwicklung und Produktion gesteckt.

Wir sind stolz darauf den Beamo zu présentieren, den
Lasercutter, mit dem Du Projekte kreieren kannst, die Du lieben
wirst. Mit dem Hashtag #madewithbeamo lasst Du dich von
anderen Mitgliedern der FLUX Community inspirieren. Bitte teile
Deine Kreationen online mit uns. Wir kdnnen es kaum erwarten
zu sehen, wie Du deinen Beamo verwendest und welche
erstaunlichen Dinge DU kreieren wirst!

Um das gleiche Ziel zu verfolgen, das wir seit dem ersten Tag
hatten, arbeiten wir eng mit unseren Benutzern zusammen. Bitte
z6gere nicht, uns zu kontaktieren, wir freuen uns auf Dein
Feedback. Du kannst uns jederzeit unter support@fux3dp.com
erreichen.

Viel Spass!

Dein FLUX Team
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1.1 VERWENDEN DER BEDIENUNGSANLEITUNG

Diese Bedienungsanleitung muss vor der ersten Verwendung
des Beamo Lasercutters sorgfaltig gelesen und beachtet
werden. Die Nichtbeachtung der in der Anleitung aufgefihrten
Punkten kann zu Personen- und / oder Sachschaden fihren.
Kein Teil dieses Handbuchs darf ohne die vorherige
Zustimmung von FLUX Inc. in irgendeiner Form reproduziert,
bearbeitet oder gedndert werden. Die Rechte zur
Reproduktion in irgendeiner Form sind vorbehalten. FLUX Inc.
behalt sich das Recht vor, die Spezifikationen der im
Benutzerhandbuch beschriebenen Hardware und Software

jederzeit und ohne vorherige Ankiindigung zu andern.

Die folgenden Symbole erleichtern das Verstandnis dieses

Handbuchs:

& Warnung: Dieser Bereich stellt eine besondere Gefahr fir den
Benutzer oder fur die Wartung verantwortliche Person dar, wenn

die Bedienungsanleitung nicht beachtet wird.

Warnung: Achte in diesen Bereichen besonders auf die
moglichen Gefahren von Laserstrahlen.

Zusétzliches Zubehdr muss mit dem Beamo kompatibel
sein. Bei Fragen wende Dich sich bitte an den FLUX-Support:
support@flux3dp.com



mailto:support@flux3dp.com

1.2 CO2 LASER GRUNDLAGEN

Der Zweck eines Lasercutter /-gravierers besteht darin, einen
Hochleistungs-Laserstrahl auf ein Werkstiick zu fokussieren, das die hohe
Energie des Laserstrahls absorbiert. Es brennt oder verdampft sofort und
ermoglicht das Schneiden oder Gravieren entlang der Bewegung des

Laserstrahls.

Mirrors

Spiegel

In der Maschine befinden sich drei Spiegel. Der erste Spiegel befindet
sich in einer festen Position, und der zweite und dritte Spiegel werden
von Motoren angetrieben, um den Laserstrahl in die richtige Position im
Arbeitsbereich zu flhren. Der zweite Spiegel bewegt sich vor und zuriick,
um die Position der Y-Achse zu steuern. Der dritte Spiegel bewegt sich

nach links und rechts, um die Position der X-Achse zu steuern.



Laser

Der Beamo ist mit einem 30W
CO2-Laser ausgestattet. CO2-Gas
ist in einer Glasrohre eingekapselt.
Wenn eine Hochspannung an die
Laserréhre angelegt wird, wird das
Gas erregt und erzeugt einen
unsichtbaren Laserstrahl mit einer
Wellenlédnge von 10,6 pm. Ein
paralleler Strahl mit einem
Durchmesser von etwa 5mm wird
vom Rohrende emittiert. Aufgrund
der geringen Divergenz kann
dieser parallele Strahl mit
geringem Energieverlust von
innerhalb der Maschine
Ubertragen werden.

Fokuslinse

Nach der dritten Reflexion trifft
der Laserstrahl direkt auf die
Oberflache des Werkstlicks. Um
eine hohere Energiedichte zu
erreichen, fokussiert die Fokuslinse
diesen parallelen Strahl von etwa 5
mm Durchmesser auf etwa 0,2
mm. Wenn der Laserstrahl richtig
fokussiert ist, reicht ihre Energie
aus, um nichtmetallische
Materialien wie Holz und Acryl zu
verbrennen.



1.3 SICHERHEIT & LASERKLASSE

Lese die folgenden Sicherheitsvorkehrungen vor der
Inbetriebnahme des Beamos sorgfaltig durch! Der Beamo
verwendet einen Hochleistungslaser-Strahl. UnsachgemaBe
Handhabung kann zu Feuer, Sehbehinderung,
Hautverbrennungen oder dem Einatmen von giftigen

Substanzen fihren.
&Wichtige VorsichtsmaBBnahmen:

1. Lasse die Maschine wahrend des Betriebs niemals
unbeaufsichtigt.

2. Stelle sicher, dass sich im Arbeitsbereich ein
Feuerldscher befindet.

3. Versuche nicht, das Gerat ohne Genehmigung des
FLUX-Supports zu reparieren oder zu modifizieren.

4. Schaue nicht auf die vom Laser erzeugte Flamme.

5. Stelle sicher, dass das zu verarbeitende Material beim
Verbrennen bei hohen Temperaturen keine Gefahr

darstellt.



Benutzersicherheit

1. Alle Mitarbeiter, die die Maschine bedienen, missen die

Sicherheitsvorkehrungen lesen und die Anweisungen

befolgen. Kontaktiere den FLUX-Support, wenn Du Fragen

zur Verwendung und Sicherheit hast: support@flux3dp.com

Kinder bendtigen jederzeit die Aufsicht und Unterstiitzung

eines Erwachsenen.

3. Betriebsumgebung:

A.
B.

Stelle die Maschine an einem gut belifteten Ort auf.
Vermeide Regen, Feuchtigkeit, Flissigkeiten oder direktes
Sonnenlicht.

Die Umgebungstemperatur sollte 5°C - 35°C (41°F - 95°F)
und die Luftfeuchtigkeit 10% - 75% betragen

Stelle beim Ventilieren ins Freie sicher, dass wechselnde
Bedingungen nicht dazu fiihren, dass extreme
Temperaturen oder Luftfeuchtigkeit die Maschine durch
den Abluftkanal beeintréchtigen. Trenn den Kanal von der
AuBenluft, wenn die Maschine nicht benutzt wird.

Stelle die Maschine auf eine stabile Oberflache, damit sie

nicht wackelt oder umkippt.


mailto:support@flux3dp.com

Elektrische Sicherheit

Die Maschine ist in 2 Versionen erhéltlich: 110V und 220V.
Verwende keine andere Stromquelle als die
Standartwechselspannung. Wende dich im Zweifelsfall an
den FLUX-Support. (110V: 100-127V / 220V: 200-240V)
Stelle sicher, dass der Schutzleiter richtig angeschlossen ist.
Bei nicht ordnungsgemaBer Erdung kann eine statische
Spannung erzeugt werden, welche die Leistung
beeintrachtigen und sogar das Risiko eines Stromschlags
erhdhen kann.

Verwende kein beschadigtes Netzkabel.

Schalte das Gerat aus und ziehe den Netzstecker aus,
wenn Du die Maschine mit Zustimmung des

FLUX-Supports wartest oder zerlegst.



A.
B.

C.

D.

Brandschutz
Lege nichts in das Gerét, das nicht laserkompatibel ist.
Informationen zu laserkompatiblen Materialien (S. ??7?).
Staple keine Materialien und versuche nicht, zwei oder
mehr Schichten gleichzeitig zu schneiden.
Entferne Schmutzreste im Gerat, wenn sie sich ansammeln.
Lasse den Beamo niemals unbeaufsichtigt, wéhrend er
arbeitet. Bleibe immer in Sichtweite. Schaue h&ufig hinein.
Wenn sich im Gerat eine dauerhafte Flamme befindet, die
nach dem Bewegen des Lasers nicht erlischt:
Schalte die Maschine aus und ziehe den Netzstecker aus.
Wenn dies moglich und sicher ist, I6sche das Feuer mit
einem feuchten Handtuch. Beachte, dass Wasser die
Maschine beschadigen kann.
Alternativ kannst Du das Feuer auch mit einem
Feuerldscher |6schen. Beachte, dass Feuerldscher die
Maschine beschadigen kénnen.
Wenn das Feuer nicht geléscht werden kann oder sich
auBerhalb der Maschine ausbreitet, rufe die Feuerwehr

an.



Rauch- und Feinstaubschutz

1.

Achte beim Ventilieren im Freien darauf, dass die Abluft
Nachbarn oder Passanten nicht stort, und vergesse nicht,
die moglicherweise geltenden ortlichen
Luftqualitatsvorschriften zu tberpriifen.

Wenn ein starker, scharfer Geruch - der auch Augen-,
Nasen- oder Rachenreizungen verursacht - festgestellt
wird oder sichtbarer Rauch bei geschlossenem Deckel aus
der Maschine austritt, halte sofort an und tberpriife die

Ventilation erneut.



Betriebssicherheit

1. Schaue nicht auf die vom Laser erzeugte Flamme.

2. Stabilisiere das Gerat, um zu verhindern, dass es sich bewegt oder
umkippt.
Bei Verbrennungen arztlichen Rat einholen.

4. Trage beim Reinigen von Schmutzresten Handschuhe.
Lasse das Geréat von zwei Personen tragen, wenn das Gerat

transportieren wird.

& Stelle Dein Beamo ab, wenn...

1. sich im Geréat ein Feuer befindet, das nach dem
Ausschalten des Lasers anhalt.

2. der Laserkopf stehen bleibt, aber der Laserstrahl
eingeschaltet bleibt.

3. ein ungewohnliches Gerdusch oder Licht vom Gerat
kommt.

4. Du Schaden an den Innenteilen des Gerats siehst.

Laserklasse

Die Beamo-Einheit ist ein Laserprodukt der Klasse 1, das einen
eingebetteten CO2-Laser der Klasse 4 enthalt. Da der Laser der
Klasse 4 vollstandig in einem Gehause der Klasse 1 enthalten
ist, wird dieses Laserprodukt wéahrend allen Betriebsvorgangen

als Laserprodukt der Klasse 1 bezeichnet.

(€ K
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2.1 WAS IST IN DER SCHACHTEL?

1. Stelle die Schachtel auf den Boden und &ffne sie.

2. Entferne den Verpackungsschaum an den vier Ecken und
nehme die Maschine aus der Verpackung. Lasse das Gerat
von zwei Personen aus der Schachtel heben. Bewahre die
Verpackung fir den Fall auf, dass Du die Maschine in

Zukunft transportieren musst.




3.

4.

Offne den Deckel, nimm den Entliiftungsschlauch und das
Zubehor-Kit heraus.

CRAFT YOUR IMAGINATION

Inhalt des ZubehérKits: : (D Wi-Fi dongle @ Schmierdl
@ Schlauchpride @ Klebeband ® Netzkabel ® kleine
Gabelschlissel @ Torx Schlissel ® Trichter @ Testmaterial

@
v

®

© @




5. Vorderansicht: (D Laserkopf @ Fokusleiste 3 Wabenplatte
@ Touchscreen ® Ein-/Aus-Schalter ® durchsichtiger
Deckel

6. Ruickansicht: M USB Anschlisse @
Netzwerkanschluss @ Stromanschluss (110V/230V)
@ Abluftventilator




2.2 ZUSAMMENBAU

1. SchlieBe das Netzkabel an.
2. Stecke den Wi-Fi-Dongle in einen der beiden USB-Anschlisse
auf der Rickseite des Gerats. Drehe die Antenne fir eine

bessere Verbindung nach oben.

3. Verwende das mitgelieferte Rohr. Schiebe die Rohrbride um
das groBere Ende des Kanals, montiere das Rohr und klemme
es Uber den Lifterauspuff auf der Riickseite Deines Beamos.

Ziehe die Klemme mit dem kleinen Schraubenschlissel fest.




2.3 NETZWERKEINRICHTUNG

Dricke den Netzschalter, um die Maschine einzuschalten.

Der Start dauert ca. 1 Minute.

Tippe auf dem Touchscreen auf Settings> Internet> Setting,

wahle ein Wi-Fi-Netzwerk aus und gib dessen Passwort ein.

Eine IP-Adresse zeigt an, dass das Gerat angeschlossen ist.
Starte den Beamo neu, wenn die Netzwerkeinrichtung

abgeschlossen ist.
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2.4 SOFTWARE HERUNTERLADEN

1. Lade die neueste Version "Beam Studio -- Stable” aus dem
Download-Bereich auf der offiziellen FLUX-Website:

https://flux3dp.com/downloads

~e Beam Studio - Stable

.

S [W1.09-Windows X64

r Beam Studio - Beta
- y ]

=7 (103 Windows %64

2

.
]
CHANGELOG DOWNLOAD

Windows: Um zu Uberpriifen, welche Version herunterladen
werden muss, klicke mit der rechten Maustaste auf das
Symbol "Dieser PC"> Eigenschaften und suche nach
"Systemtyp". Lade die x86-Version fiir 32-Bit-Systeme und
die x64-Version fir 64-Bit-Systeme herunter.

MacQOS: Lade die DMG-Datei herunter und offne sie.
Ziehe die Beam Studio-App in den Programmordner.

Flhre Beam Studio im Ordner "Programme" aus.

2. Beim ersten Ausfihren von Beam Studio wird ein

Sprachdialogfeld angezeigt. Wéhle English > FLUX beamo.

Fehlerbehebung: Software wird unerwartet beendet (p.93)


https://flux3dp.com/downloads

Beambox Connection Setup

Fleessa gt 1o Baarnbie lucpad

*L Gick oushped “HRing s SIma TRt s SRng.*

. Bract youe Wi and arbartha passwnnd.
3. We 10 seconds. e ielees P AJdrass vould show at “Seting = SImemeE®,
A ITWAF = Jravaliabia, you conmact wilh he stharsal poet, with retecs whiksh srabiec DHOF,

5. Enfer MWeching IF-hera

Iutar al Vigan

3. Gebe die IP-Adresse Deines Beamos in das Textfeld ein und klicke

auf Start

4. Gehe zu Meni> Maschine oder klicke auf das
Kamerasymbol in der unteren linken Ecke, um zu
Uberprifen, ob der Name Deines Beamos gefunden

werden kann.

% Wenn Du diesen Dialog versehentlich tberspringst, klicke
auf Men(i> Maschine> Maschinen-Setup

Starte Deinen ersten Laserjob!



2.5 ERSTER LASERJOB

1. Focus einstellen

Lege ein Werkstlck in die Maschine. Drehe die Fokusleiste
nach unten, bis sie vertikal ist. Lose den Fokusring des
Laserkopfs und senke den Laserkopf ab, bis die Fokusleiste

auf dem Werkstlck aufliegt. Ziehe den Fokusring des

Laserkopfs fest und drehe die Fokusleiste nach oben.

A Die Fokusleiste sollte auf dem Werkstlick
aufliegen

& Der Fokus muss an jede Materialdicke angepasst werden.



2. Kamera Vorschau
Klicke in Beam Studio unten links auf das Kamerasymbol
(B1) und wahle Dein Gerat aus der Liste aus. Der
Vorschaumodus ist bereit, wenn der Mauszeiger zu einer
Kamera wird (8). Klicke und ziehe den Mauszeiger, um
eine Vorschau des Arbeitsbereichs anzuzeigen. Klicke erneut
auf @ oder driicke ESC, um den Vorschaumodus zu

verlassen.

Hom

T Wenn das Ergebnis der Vorschau nicht korrekt ist, klicke
auf MenUi> Machine> choose Machine> Calibrate Camera, um
die Kamerakalibrierung auszufiihren. Vergleiche das rot
gepunktete Quadrat mit dem tatsachlich eingravierten
Quadrat. Passe die Position manuell an, um die beiden
Quadrate aufeinander zu positionieren.



2. Offne Test Datei

Klicke im Meni > File > Samples > First Engraving.

Beam Studio N8 Edit View Machines Window Help

Example of beamo
Material Testing Sulte - Cut (Simple)

Material Testing Suite - Cut
L J s accone #S Material Testing Suite - Engraving . [290,

Klicke auf “Export”, wahle Deinen Beamo aus der Liste aus

und klicke auf Start, um den Auftrag zu beginnen.

W Loravng L

| = O g Ly -

Cutieeg Layes:
Farameise. -

Pamer




3. Test Resultat

Wenn das Ergebnis zu hell oder verschwommen ist,

tUberpriife bitte, ob der Fokus genau richtig eingestellt ist.
Wenn der Fokus stimmt, das Ergebnis jedoch schlecht ist,
Uberpriife den optischen Pfad erneut. Siehe ,, Anpassung des
optischen Pfads” (S. 58). Wenn die Position des Ergebnisses
mit der Kameravorschau variiert, Uberpriife den Fokus erneut

oder lese ,,Problem mit der Kameraausrichtung” (S.88).
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3.1 SOFTWARE BENUTZEROBERFLACHE

A. Objektplatzierung

Q : kleiner und grofer zoomen

[ :
: Gruppieren von mehreren Elementen

l;I-'[: Gruppierung aufheben

— : horizontale Ausrichtung

+ : vertikale Ausrichtung

| : horizontale Ausrichtung von mehreren Elementen zwischen dem
linken und rechten Rand

— : vertikale Ausrichtung von mehreren Elementen zwischen dem
oberen und unteren Rand

: Vereinigt den Umriss aller Objekte, die ausgewahlt sind

: Subtrahiert die vordersten Objekte vom hintersten Objekt



» :Zeichnet den Umriss des Bereichs, der von den
ausgewahlten Objekten Uberlappt wird

': Zeichnet alle nicht Gberlappenden Bereiche der gewahlten
Objekte und macht Gberlappende Bereiche transparent

A\: horizontal spiegeln
G: vertikal spiegeln

B+ : Exportiert den Auftrag zu Deinem Beamo

B. Objektbearbeitung

k : Auswahl
"] : Importiert JPG/PNG/SVG/DXF Dateien. Du kannst auch eine

Datei auf die Arbeitsflache ziehen
T : Schrift

D : Rechteck

O : Oval

O : Polygon

" . Stift

2222 : Kopiert ausgewahlte Objekte in eine rechteckige Ausrichtung
(O

: Aktivieren / Deaktivieren der Kamera Vorschau



C. Ebenenverwaltung

+ : Erstelle und benenne eine neue Ebene

@[ : Ldsche die ausgewahlte Ebene
A : Umbenennen

4 ¥ . Reihenfolge: Die Ebenen werden von oben nach unten

ausgefihrt

D. Leistungs- und Geschwindigkeitseinstellung

Parameter fur haufig verwendetes Material finden sich in der
Dropdown-Liste "Parameters ...". Benutzerdefinierte Parameter kénnen
mit "Save" eingestellt werden. Verwende "Manage", um gespeicherte
Parameter zu bearbeiten oder zu entfernen. Die Leistung wird in Prozent
eingestellt, was bedeutet, dass der 30W-Laser 30W abgeben kann, wenn
die Leistungseinstellung 100% betragt. Die Geschwindigkeit wird in mm
pro Sekunde eingestellt.”Execute” kann so eingestellt werden, dass

dieselbe Aktion auf einer einzelnen Ebene wiederholt wird.

‘% Die Parameter kénnen je nach Material variieren. Teste beim ersten
Ausflihren die vorgeschlagenen Parameter und optimiere sie, um bessere

Ergebnisse zu erzielen.

T Die Leistungseinstellung sollte 70% nicht Gberschreiten, um einen

drastischen Verbrauch der Laserrdohre zu vermeiden.



3.2 TOUCHSCREEN BENUTZEROBERFLACHE

Home Verbunden mit Wi-Fi

e

|
“ START
e (

)
MAINTAIN TRACE
( ) C )
& tht
BROWSE SETTINGS
( ) C )

vordere Auftrége

Geratewartung Aktiviere Smart Trace
Online Daten Maschineneinstellungen



3.3 PIXELGRAFIK GRAVUR

Pixelgrafik und Vektorgrafik sind zwei verschiedene Arten von digitalen
Bilddateien. Pixelgrafik ist ein Bildtyp, der aus zahlreichen quadratischen
Bildpunkten besteht und sich hauptsachlich fir Fotografie eignet. Die
Qualitat héngt jedoch von der Auflésung ab, sodass das Bild beim
Andern der GréBe gezackt oder unscharf werden kann. JPG und PNG
sind zwei haufig verwendete Pixelgrafik-Formate, die beide mit Beam

Studio kompatibel sind.

Grafikauflésung

Die Grafikauflésung kann in Beam Studio tber Menii> Edit> Document
Setting eingestellt werden. Die Grafikauflésung steht fir die Feinheit und
Qualitat der Gravuren. Du erhélst detailliertere Ergebnisse, wenn die
Aufldsung auf "High" eingestellt ist. "Low" bedeutet kiirzere
Arbeitszeiten bei gleichzeitig rauerer Qualitat. Die Qualitat steht fir den
Abstand jeder vom Laser abgetasteten Linie, der 0,2 mm / 125 dpi, 0,1
mm / 250 dpi und 0,05 mm / 500 dpi entspricht.

Belichtungsschwellenwert

Der Belichtungsschwellenwert kann festgelegt werden, wenn eine
Pixelgrafik in Beam Studio importiert wird. Klicke bei "Laser Config" auf
die Zahl und sehe die Optionen "Shading" und "Threshold". Wenn



"Shading" deaktiviert ist, werden Bilder in monochrome Bilder
umgewandelt, die fur integrierte "monochromatische Gravur" -Parameter
optimiert sind. Wenn "Schattierung" aktiviert ist, werden Bilder in
Graustufen umgewandelt, die fiur die vorinstallierte "Monochromic
Engraving" -Parameter optimiert sind. Wenn "Shading" aktiviert ist,
werden Bilder in Graustufen umgewandelt, die fir die vorinstallierte
"Shading Engraving” -Parameter optimiert sind.

Der Wert "Threshold" kann angepasst werden, wenn "Shading"
deaktiviert ist. Diese Funktion basiert auf dem RGB-Farbmodell, das
Farben von 1 bis 255 definiert. 1 steht fir Schwarz und 255 fir Weil3.

Wenn Du beispielsweise den Schwellenwert auf 125 einstellst, werden alle

Farben Gber 125 in Weil3 umgewandelt.



3.4 VEKTORGRAVUR

Eine Vektorgrafik besteht aus Pfaden, die durch mehrere Punkte definiert
sind. Jeder Pfad, jede Kurve oder jedes Polygon wird mit einer eigenen
Formel erstellt. Dies bedeutet, dass die Qualitdit beim Andern der
BildgroBe nicht beeintréchtigt wird. Vektorgrafiken eignen sich besonders
fur Logos und Druckerzeugnisse. Beam Studio ist mit den Vektorformaten

SVG und DXF kompatibel.

Ebenen sind eine gute Moglichkeit, ein komplexes Bildmaterial beim
Erstellen einer Vektorgrafik zu verwalten. Dies kann man zum Beispiel mit
Adobe lllustrator oder Inkscape. Das Design kann entweder nach
verschiedenen Farben oder nach verschiedenen Ebenen organisiert
werden. Beam Studio kann die Ebeneneinstellung lesen, sodass fir jede
Ebene unterschiedliche Gravurparameter festgelegt werden koénnen.

Schneiden und Gravieren kann damit in einem Auftrag gesendet werden.



3.5 VERGLEICH ZWISCHEN PIXEL- UND
VEKTORFORMAT

Pixel Vektor
Format JPG / PNG SVG / DXF
V. d flachige Gravur Liniengravur/
erwenaung (monochrome/shading) Schneiden

3 Wihle das Vektorformat fiir alle Schneidauftrage.

3.6 EBENEN EINSTELLEN

Du kannst den Ebenenstil beim Importieren einer SVG-Datei tber "Layer",
"Color" oder "Single Layer" festlegen.

Layer: Die Ebenen werden gemal den vorherigen Ebeneneinstellungen
kategorisiert

Color: Die Ebenen werden nach ihrer Farbe kategorisiert

Single Layer: Flgt alle Ebenen zu einer einzigen Ebene zusammen

3.7 SAVE



Mit der Funktion "Save" kénnen alle Elemente in der Datei gespeichert
und bearbeitet werden. Dies ist nitzlich, wenn das Design bearbeitet
werden muss, der groBte Teil der Grafik jedoch gleich bleiben sollte.

Suche diese Funktion unter Meni> File> Save.



3.8 EMPFOHLENE DESIGN-SOFTWARE

AutoCAD ist eine CAD-Software, die auf genaue Abmessungen,
Volumenkorper  spezialisiert  ist.  Geeignet fir  Architektur- und
Ingenieuranwendungen. AutoCAD kann das mit Beam Studio kompatible
DXF-Format exportieren. Wenn die Abmessungen beim Import nicht mit
dem urspriinglichen Design Ulbereinstimmen, zeichne in Autocad ein
100-mm-Quadrat und importiere es in Beam Studio, um die korrekte

GroBe zu berechnen.

Adobe lllustrator ist eine Vektorgrafik-Software, die fur Verlagswesen,
Websites und andere Anwendungen geeignet ist. lllustrator kann das
SVG-Format exportieren, das mit Beam Studio kompatibel ist. Bitte wahle
beim Exportieren von SVG-Dateien das SVG 1.0-Format. Wahle

"Gliederung" fur Texte, "Einbetten" fir Bilder.

Inkscape ist eine kostenlose Open-Source-Software fiir Vektorgrafiken.
Seine Funktionen dhneln denen von lllustrator. Inkscape kann SVG-, JPG-
und PNG-Formate exportieren, die mit Beam Studio kompatibel sind.
Bitte wahle beim Exportieren des SVG-Formats das Format "Normales

SVG".



3.9 SMART TRACE

Smart Trace verwendet die integrierte Kamera, um die Umrisse
einfacher Muster nachzuzeichnen. Der Vorgang ist recht einfach:
Zuerst zeichne etwas auf Papier und die Kamera in Beamo konvertiert
lhre Zeichnung in eine digitale Datei. AnschlieBend kannst Du die
Datei auf die Materialien lhrer Wahl lasern. Diese Funktion findest Du
auch in unserer App “BeamCam”.

1. Platziere das Bildmaterial im Arbeitsbereich.

B s




3. Klicke auf "Trace Image" und ziehe ein Quadrat um das Bildmaterial,
das Du nachzeichnen méchtest. Du siehst eine Vorschau der Gravur

lhres Beamo. Alles in Schwarz wird graviert und sonst nichts.

4. Entferne kleine Details wie Schmutz und storende Punkte,

indem Du den Belichtungsschwellenwert anpasst.

Paramaters
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Klicke auf "Preview" und wenn Deine Nachzeichnung fertig ist

klicke auf "Apply".
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6. Stelle die Leistung und Geschwindigkeit ein und starte den
Laserjob. Bereite dich darauf vor, Dein neu digitalisiertes Kunstwerk

zu sehen!
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4.1 NEUE MATERIALIEN TESTEN

Zum Testen verschiedener Geschwindigkeits- und
Leistungseinstellungen mit einem neuen Material,
importiere die "Material Testing Suite" aus dem Menii

> File > Samples.

MATERIAL TESTING SUITE
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4.2 HOLZ

Holzarten

Mitteldichte Faserplatte (MDF)

MDF wird aus Holzfasern und Harzbindemitteln hergestellt, die
unter hoher Temperatur und hohem Druck gebildet werden. Es
wird MDF mit niedrigem Formaldehydgehalt empfohlen, um

schadliche Dampfe zu reduzieren.

Sperrholz

Sperrholz wird durch zusammengeklebte Schichten aus
Holzfurnier hergestellt. Es wird Sperrholz mit niedrigem
Formaldehydgehalt empfohlen, um schadliche Dampfe zu

reduzieren.

Massivholz
Massivholz kann wegen den Wachstumsringen eine

ungleichmaBige Maserung aufweisen, wenn es graviert wird.

Gravurergebnisse auf Holz

Je langsamer der Laser bewegt, desto dunkler das gravierte
Ergebnis. Je héher die Leistung, desto tiefer die Schnitttiefe.
Um einen dunkleren Effekt zu erzielen, ist eine niedrige

Geschwindigkeit meist nltzlicher als eine hohe Leistung.



Brandflecken auf Holz verhindern

Decke die Oberflache vor der Verarbeitung mit Klebeband ab
oder entferne die Markierungen mit Schleifpapier. Eine
Alternative ist, das Holz zu befeuchten, es kann jedoch zu

Unebenheiten der Oberflache kommen.

Brandkante bei Holz reduzieren

Reinige die Kanten mit Alkohol oder Seifenwasser oder
wahle Holz mit geringerer Dichte, um die
Schnittgeschwindigkeit hoher zu wahlen, damit hellere

Kantenspuren entstehen.

4.3 LEDER

Lederarten

e Kunstleder
Die Oberfléache des Kunstleders ist hauptséchlich in zwei
Arten unterteilt: PU (Polyurethan) oder PVC
(Polyvinylchlorid). PVC wird fir die Laserbearbeitung
dringend nicht empfohlen (siehe gefahrliche
Materialien). Wenn PU nicht vollstandig verbrannt wird,

kann Blausaure entstehen!



e Echtleder
Um die Dicke und Haltbarkeit zu erhéhen, wird das
Leder im Allgemeinen durch Gerben verarbeitet. Die
gegerbte Schicht erfordert beim Schneiden eine

langsamere Geschwindigkeit.



Brandflecken auf Holz verhindern
Leder verbrennt und krauselt sich leicht, wenn es mit einem Laser
bearbeitet wird. Das Einweichen des gesamten Lederstlicks in

Wasser vor der Bearbeitung sollte helfen.

Liiftungsanforderungen fiir Leder

Die Leder Proteinzusammensetzung enthalt viele Aminogruppen
und Benzolringe, so dass wéhrend der Verbrennung Stickoxide
oder aromatische Verbindungen entstehen kdnnen. Wenn das
Leder langere Zeit graviert oder geschnitten wird, sollten die
Liftungsanforderungen viel héher sein als bei Holz oder Acryl. Es

wird empfohlen, einen Luftfilter zu verwenden.

4.4 ACRYLGLAS

Acryl identifizieren

Der wissenschaftliche Name lautet Polymethylmethacrylat und
ist auch als PMMA oder Plexiglas bekannt. Es ist einer der
wenigen Kunststoffe, die per Laser verarbeitet werden kann. Es
ist wichtig zu unterscheiden, ob es sich um Acryl oder andere
Kunststoffe handelt, die nicht fiir die Laserbearbeitung geeignet
sind (d. H. PVC oder PC). Bei der Bearbeitung sind die Kanten
vom Acryl scharf und klar. Wenn es gelbliche Brandspuren gibt,
ist das Material kein Acryl. Keine Brandflecken bedeuten jedoch

nicht, dass es sich um Acryl handelt



Kratzer auf Acrylglas

Kratzer kénnen mit Kunststoffpolitur entfernt werden.

Reinigen von Acryl

Es wird empfohlen den Film bei der Bearbeitung auf dem Acryl
zu lassen, ausser es werden Graustufenbilder graviert. Du kannst
das Acryl mit einem Alkoholtupfer reinigen. Beachte, dass dies

andere Oberflachenfehler verursachen kann.

4.5 PAPIER

Brandflecken auf Papier verhindern

Beim Schneiden von Papier kénnen leicht gelblich karbonisierte
Brennkanten entstehen. Die Verwendung von Universal-Ton
oder anderen niedrigviskosen Substanzen kann die Verfarbung
bis zu einem gewissen Grad effektiv entfernen, ohne die

Oberfléche des Papiers zu beschadigen.

Wellpappe
Beim Schneiden von Wellpappe kann der Karton aufgrund der
Fehlfokussierung die untere Schicht in Brand geraten. Bespriihe

die Unterseite mit Wasser, um die Brandgefahr zu verringern.



4.6 GLAS

Glas bricht leicht, so dass die Laserleistung nicht zu stark sein

sollte. Wéhle dickeres Glas fiir bessere Moglichkeiten.

4.7 METALL

Eloxiertes Aluminum
Das Eloxieren ist eine Oberflachenbehandlung, die eine
Oxidschicht auf der Aluminiumlegierung bildet. Durch

Lasergravur wird die Oxidschicht zersetzt.

Edelstahl (mit Beschichtung oder Hybridlaser)

Edelstahl reflektiert aufgrund seiner Wellenldnge den gréBten
Teil der Energie eines CO2-Lasers. Spezielle Oxidationsmittel
sind erforderlich, damit der Edelstahl bei relativ niedrigen
Temperaturen oxidieren und abdunkeln kann. Trage beim
Auftragen der Beschichtung Arbeitshandschuhe. Wenn Du das
Hybrid-Laser-Add-On verwendst, kann der Laser direkt auf

Edelstahl gravieren.



4.8 ANDERE SICHERE MATERIALIEN

Stein, Zement, EVA-Schaum, Baumwolle, Leinen usw.



4.9 GEFAHRLICHE MATERIALIEN

PVC

Ein Material, das nicht mit Laser verarbeitet werden darf.
Beim Verbrennen entsteht HCI (Salzsduregas), das die
Lunge schadigt und Maschinenteile angreift. PVC
produziert beim Verbrennen auch stark krebserregende
Stoffe wie Dioxin oder polychlorierte Biphenyle. PVC
wird haufig als Aufkleber, Folie oder transparente Folie

verwendet.

ABS

Ein Material, das nicht mit Laser verarbeitet werden darf.
Es brennt "Schmutzig", wobei A (Acrylnitril), B (Butadien)
und S (Styrol) erzeugt werden, die Karzinogene der
Kategorien 2B, 1 und 2B sind.

(Krebserregend!)

Kunststoffe mit Chlor, Benzol, Ammoniak, Fluor, Phenol,
Aldehyd oder mit hexagonalem Benzolring in seiner

Molekulformel



Beim Verbrennen von Kunststoffmolekiilen mit diesen
Elementen oder organischen Strukturen ist die
Wahrscheinlichkeit, Karzinogene und toxische Substanzen zu

produzieren, extrem hoch.

Laserbearbeitung wird nicht empfohlen!

Das Molekiil darf keinen Benzolring enthalten, © H

damit das Material lasersicher ist » (szt::
H H
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5.1 INSPIRATIONEN

OO0 .
; https://pse.is/KFDPQ
[=];

* Pinterest https://pse.is/JXRR5

i Mit "laser engraving" auf Pinterest weitere |deen finden!
* Ponoko Laser Gravur Ideen https://pse.is/HQARL

5.2 VEKTOR DATEIEN

* The Noun Projects https://thenounproject.com/

* Freepik http://freepik.com/

5.3 DATEIEN ZUM SCHNEIDEN

e DXF Projekte https://dxfprojects.com/
® Canon Creative Park http://cp.c-ij.com/sc/index.html

* Papier Modelle http://paper-replika.com/

5.4 FREIE SCHRIFTEN



e Dafont https://www.dafont.com/

% In der Kategorie Kalligrafie findest Du zusammengehéngte Schriften
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6.1 ALLES SCHMIEREN

Das regelméfBige Reinigen und Schmieren der
Fihrungsstangen und der Schiene kann die Lebensdauer
der beweglichen Teile verlangern. Wir empfehlen das

einmal alle 1 - 2 Wochen.

1. Wische den Schmutz auf der Fiihrungsstange und der
Schiene mit einem Papiertuch ab.
2. Trage Schmiermittel auf die Fihrungsstangen der Y-Achse auf.
3. Trage Schmiermittel oben und seitlich auf die lineare
Schiene der X-Achse auf.
4. Bewege den Laserkopf mehrmals auf und ab, links und

rechts, um das Schmiermittel gleichméfBig zu verteilen.



6.2 REINIGUNG DES ARBEITSBEREICHS

Entferne Ubrig gebliebene Abschnitte aus dem

Arbeitsbereich, weil eine Ansammlung Brandgefahr

verursachen kann.

1. Entferne die Wabenplatte, indem Du zuerst den
Laserkopf in die obere linke Ecke bewegst, die

Wabenplatte leicht anhebst und in Deine Richtung

ziehst.

Achte auf die scharfe Kanten, um Verletzungen zu vermeiden.

2. Verwende einen Staubsauger, um die Reste unter der
Wabenplatte zu reinigen. Reinigungsmittel kann

verwendet werden, um die Flecken zu entfernen.



3. Bringe die Wabenplatte wieder vorsichtig an den
urspriinglichen Ort und schiebe sie hinein. Achte darauf,

den Laserkopf oder die Schienen nicht zu beschadigen.



6.3 REINIGUNG DER LINSE

Verwende nach jeweils 40 Arbeitsstunden Brillen-
Wischtlcher oder feuchte Wattestabchen, um die Linse und
die Spiegel zu reinigen. Reibe die Spiegel nicht stark, um
eine Beschadigung der Spiegelbeschichtung zu vermeiden.
Dadurch wird der Beamo zuverldssig funktionieren und es

werden keine bleibende Schiaden entstehen.

First Reflecting Mimor

Second Reflecting
Mirror

1. Reinige die drei Spiegel.




2. Die Fokuslinse befindet sich im Linsenhalter unter dem
dritten Spiegel. Entferne die Wabenplatte, um Platz flr den
nachsten Schritt zu schaffen. Drehe den Linsenhaltering im
Uhrzeigersinn (normales Rechtsgewinde), um den

Linsenhalter zu l6sen und zu entfernen.

A 16se und entferne den Linsenhalter

Drehe den silbernen Ring am Linsenhalter gegen den
Uhrzeigersinn, um die Linse herauszunehmen. Verwende

eine Zange, wenn der Ring zu fest zum Drehen ist.



6.4 WARTUNG DES WASSERKUHLERS

Wasser nachfiillen

Wenn Du einen niedrigen Wasserstand hast oder auf dem
Touchscreen im Dialogfeld "# 900 Cooler Off" angezeigt
wird. Bitte fiille Wasser in den Wassertank.

1. Ziehe den Stecker aus der Steckdose.

2. L&se mit dem InbusschlUssel vom Zubehorsatz die

6-Torx-Schrauben und entferne den hinteren Deckel.




4. Fille den Tank mit destilliertem Wasser. Beobachte den
Wasserstand sorgfltig, um ein Uberlaufen zu verhindern.

VerschlieBe den Tank, wenn der Wasserstand zu 80% voll ist.

Wasser wechseln

Es wird empfohlen, das Wasser alle 3 Monate zu wechseln.

1. Wiederhole Schritt 1 & 2 von “Wasser nachfillen”.

2. Entferne die Schlauchklemme mit einer Zange und ziehe den
Schlauch vom weil3en Anschluss des Durchflusssensors ab.
Lege die beiden Enden des Schlauchs in einen Behalter,

damit kein Wasser austreten kann.




3. Entferne den Linsenhalter vom Laserkopf und schlieBe den
Luftauslass an die Wasserleitung an. Wahle am Touchscreen
Maintain> Air Pump. Das Wasser wird am anderen Ende
heraus geblasen. Driicke erneut auf "Air Pump", wenn

Wasser aus dem Wassertank und dem Schlauch abgelassen

wird.

4. Wiederhole Schritt 3 & 4 von "Wasser nachftllen”.

5. Starte die Maschine neu. Wahle am Touchscreen Maintain> Air
Pump. Das Wasser im Tank wird in das Kihlsystem gedrickt.

Wiederhole Schritt 4, bis der Wasserstand nicht mehr abnimmt.

& UbermaBige Luftblasen in der Laserrdhre kdénnen die
Kuhleffizienz verringern. Es wird empfohlen, den Wassertank

mehr als 80% zu fullen, um die Blasenbildung zu verringern.



6.5 SPIEGEL AUSRICHTUNG

Wenn das Werkstiick nicht durch die voreingestellten Parameter
durchgeschnitten werden kann oder die Laserleistung an jeder Ecke
des Arbeitsbereichs erheblich variiert, ist der optische Pfad

moglicherweise falsch ausgerichtet und muss angepasst werden.

Werkzeug
Zubehor-Kit: @ Torx @) kleiner Gabelschlissel @ Klebeband

Eigenes Material: D 2.5mm Imbusschlissel

Sicherheitsvorkehrungen

1. SchlieBe die Augen wenn "Laser Pulse" gedriickt.

2. Wenn Du ein lautes Knacken horst, schalte die
Stromversorgung sofort aus. Wende Dich an den

FLUX-Support



3. L&se mit dem Inbusschlissel vom Zubehor-Kit die

6-Torx-Schrauben und entferne den hinteren Deckel.

Es gibt drei Spiegel und eine Fokussierlinse in Beamo.
First Reflecting Miror

THeece
Third Reflecting Mirror

* Der erste Spiegel befindet sich auf der linken Seite der
Laserrohre.

* Der zweite Spiegel befindet sich am Schlitten der
Flhrungsstange auf der linken Seite.

* Der dritte Spiegel befindet sich auf der Schiene der
X-Achse.

e Die Fokussierlinse befindet sich im Linsenhalter unter

dem dritten Spiegel.



Erster Spiegel

Ziel: Die 2 Punkte von links oben und links unten mdssen
sich tiberlappen.

1. Wahle am Touchscreen > Maintain, Der Laser wird zur
"home position” gehen. Wahle "
2. Motors".

3. Klebe ein Stlick Klebeband tber den zweiten Spiegel.

3. Bewege den Laserkopf manuell in die Position oben links.

SchlieBe den Deckel und driicke "Laser Pulse".

4. Offne den Deckel und tberpriife die Position des Punkts.
Dieser Punkt ist der Bezugspunkt fir die Einstellung. Die
Aufnahmen an anderen Positionen sollten so angepasst

werden, dass sie sich zum Referenzpunkt bewegen.



5. Bewege den Laserkopf manuell nach links unten.

6. SchlieBBe den Deckel und driicke "Laser Pulse".

7. Offne den Deckel und priife, ob sich der zweite Punkt
mit dem ersten Uberlappt. Wenn nicht, stelle die

Schrauben hinter dem ersten Spiegel ein.

& Wenn der von links unten aufgenommene Punkt nicht auf dem
Klebeband zu finden ist, ist der optische Pfad sehr falsch
ausgerichtet. Versuche es mit der mittleren linken Position
anstelle der unteren linken Position. Stelle sicher, dass sich die
Punkte oben links und mitte links lberlappen, und versuche
dann die urspriingliche Einstellung oben links und unten links.



8. Die Schrauben hinter dem ersten Spiegel steuern den im Bild
unten gezeigten Spiegelwinkel. Lése die Mutter an der
Schraube, drehe die Schraube in die gewtiinschte Richtung und
teste die Punkt-Position, bis sich die beiden Punkte tiberlappen.

Ziehe die Mutter wieder fest, wenn die Einstellung beendet ist.

erster Spiegel Punkt-Bewegung

Einstellhilfe fiir die Schrauben des Spiegels: Brandmarken am
Referenzpunkt (in diesem Fall oben links) bewegen sich beim
Einstellen der Schrauben nur wenig. Versuche also, die
Brandmarken am einstellbaren Punkt (in diesem Fall unten links)
mit den Schrauben anzupassen, und bewege den Punkt zum

Referenzpunkt, bis sie sich lberlappen.



Zweiter Spiegel
Ziel: Die 2 Punkte von der Mitte links und der Mitte rechts
mdissen sich (iberlappen

1. Klebe ein Stiick Klebeband auf den Metallring des dritten Spiegels.

2. Bewege den Laserkopf manuell in die mittlere linke Position.

SchlieBe den Deckel und driicke "Laser Pulse".

3. Offne den Deckel und lberpriife die Position des Punkts.
Dieser Punkt ist der Bezugspunkt fir die Einstellung. Die
Aufnahmen an anderen Positionen sollten so angepasst

werden, dass sie sich zum Referenzpunkt bewegen.




4. Bewege den Laserkopf manuell in die Mitte rechts.
SchlieBe den Deckel und driicke "Laser Pulse".

5. Offne den Deckel und priife, ob sich der zweite Punkt mit

dem ersten Uberlappt. Wenn nicht, stelle die Schrauben

hinter dem zweiten Spiegel ein.

& Wenn der von der mittleren rechten Ecke aufgenommene Punkt
nicht auf dem Band gefunden wird, bedeutet dies, dass der
optische Pfad sehr falsch ausgerichtet ist. Versuche es mit der
mittleren und mittleren Position anstelle der mittleren rechten
Position. Stelle sicher, dass sich die Aufnahmen von Mitte links
und Mitte Mitte liberlappen, und kehre dann zur urspriinglichen
Einstellung von Mitte links und Mitte rechts zurick.



6. Die Schrauben hinter dem zweiten Spiegel steuern den im
Bild unten gezeigten Spiegelwinkel. Lose die Mutter an der
Schraube, drehe die Schraube in die gewlinschte Richtung
und teste die Schussposition, bis sich die beiden Schiisse
tUberlappen.

Ziehe die Mutter wieder fest, wenn die Einstellung beendet

ist

Pu
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Einstellung der Laserkopfverschiebung

Ziel: Der Punkt auf dem Metallring befindet sich auf der
vertikalen Mittellinie des Rings. Der Punkt muss (ber dem

Mittelpunkt des Rings liegen.

1. Bewege den Laserkopf in die Mitte des Arbeitsbereichs

SchlieBe den Deckel und driicke "Laser Pulse".



2. Uberpriife, ob der Punkt auf der vertikalen
Mittellinie des Rings gelandet ist. Wenn ja,

fahre mit Schritt 6 fort.




Losen die 4 Innensechskantschrauben mit dem 2.5mm
Inbusschlissel.

Bewege den Laserkopf in Bezug auf die Schiene vorwarts
oder rlickwérts. Ziehe dann die 4 Schrauben wieder fest.
Driicke "Laser Pulse" und priife, ob der Punkt auf der
vertikalen Mittellinie des Rings gelandet ist. Wenn nicht,
wiederhole die Schritte 3 und 4.

Uberpriife, ob sich der Punkt Gberlappt oder iiber der

horizontalen Mittellinie des Rings liegt. Falls ja gehe zu

"Dritter Spiegel”

A oberhalb ' A unterhalb

Wenn der Punkt unterhalb der Mittellinie liegt, missen die
Schrauben des Laserrdhrenhalters eingestellt werden. Lése
den Halter an der Seite des Laserstrahlausgangs und ziehe

die andere Seite fest.




8. Uberpriife, ob der Punkt auf oder tiber der Mittellinie liegt.
Der erste und der zweite Spiegel missen angepasst
werden, wenn die Position des Laserrdhrenhalters
angepasst ist.

Dritter Spiegel

Ziel: Punkt in der Mitte des Laserstrahlauslasses.

1.

Entferne die Wabenplatte, um Platz flir Anpassungen
zu schaffen.

Lege ein Stlick Klebeband auf den Laserkopf-Auslass.

Driicke mit dem Finger auf das Klebeband, damit eine

kreisférmige Markierung sichtbar wird.

3. Bewege den Laserkopf manuell in die Mitte des

Arbeitsbereichs. SchlieBe den Deckel und dricke "Laser

Pulse".



4. Offne den Deckel und priife, ob sich der Punkt in der N3he
des Kreismittelpunkts befindet. Wenn nicht, missen die

Schrauben hinter dem dritten Spiegel eingestellt werden.



5. Die Schrauben hinter dem dritten Spiegel steuern den
Spiegelwinkel, der in der Abbildung unten dargestellt ist.
Loése die Muttern an den Schrauben und drehe die
Schrauben in die gewlinschte Richtung, bis sich die beiden
Punkte Uberlappen. Ziehe die Muttern nach dem Einstellen

wieder in ihrer Position an.

Dritter Spiegel Punkt Bewegung




Der Laser kann nun nach den obigen Einstellungen gleichmaBig
auf jeden Punkt des Arbeitsbereichs verteilt werden. Die
Leistung sollte den Anforderungen des regularen Betriebs
entsprechen. Stelle sicher, dass Du "Kamerakalibrierung" erneut
ausflihrst. Wenn die Senkrechte des optischen Pfades in
bestimmten Anwendungen erforderlich ist, kdnnen die
folgenden Schritte fir erweiterte Einstellungen ausgefihrt

werden.

Vertikalitdt des optischen Pfades (erweitert)

Ziel: Beide Punkte auf dem Linsenhalter und des

Laserstrahlausganges befinden sich in der Mitte des Kreises.

1. Bewege den Laserkopf manuell in die Mitte des
Arbeitsbereichs. Klebe ein Stlick Klebeband auf den
Metallring vor dem dritten Spiegel.

2. SchlieBe den Deckel und driicke "Laser Pulse".

3. Offne den Deckel und messe den Abstand zwischen der

Punktmitte und der Ringmitte. Den Abstand nennen wir X.




4. Lose die drei Muttern hinter dem dritten Spiegel. Drehe die
drei Schrauben gleichmaBig, damit sich der Spiegel in
paralleler Richtung vorwarts oder rlickwarts bewegen kann.
Stelle den Abstand zwischen den Metallteilen auf "X" mm

ein.

=

5. L&se den Linsenhaltering, und senke ihn auf mittlere

Hohe ab. Befestige den Linsenhalter.

6. Klebe ein Stlck Klebeband auf den Strahlausgang.

7. Befolge die Schritte unter "Dritter Spiegel" und stelle die
Schrauben hinter dem dritten Spiegel so ein, dass der Punkt
in der Mitte des Kreises landet.

8. Lasse den gesamten Linsenhalter los und entferne ihn. Klebe
ein Stlick Klebeband an die im unteren Bild gezeigte Stelle.
Ube Druck aus, um eine kreisférmige Markierung auf dem

Band zu erzielen.



» &
9. SchlieBe den Deckel und driicke "Laser Pulse". Offne den
Deckel und Uberprife den Punkt. Es gibt drei
Moglichkeiten:
e Der Punkt befindet sich in der Mitte des Kreises. Die
Anzeige des optischen Pfades erfolgt bereits vertikal.
® Der Punkt befindet sich auf der rechten Seite des Kreises.
Die Anzeige des Strahlengangs erfolgt von oben rechts und
von unten links. Lose jede Schraube gegen den
Uhrzeigersinn, um den Spaltabstand zwischen den
Metallteilen zu verringern. Wiederhole Schritt 5 - 9.
® Der Punkt befindet sich auf der linken Seite des Kreises. Die
Anzeige des optischen Pfades erfolgt von oben links und
von unten rechts. Ziehe jede Schraube halb im
Uhrzeigersinn an, um den Spaltabstand zwischen den

Metallteilen zu vergroBern. Wiederhole Schritt 5 - 9.

¥ Fuhre "Kamerakalibrierung" erneut durch, nachdem die
Einstellung abgeschlossen ist.



6.6 AUSTAUSCH DER LASERROHRE

Werkzeug
Zubehor-Kit: @ Torx @) kleiner Gabelschliissel @ Trichter
Laserrdhrenzubehdr: ® Schlauchstecker (7) Kabelbinder

Eigenes Material: Q) Kreuzschlitzschraubendreher @ Spitzzange
® Seitenschneider @ Handtuch 0 Wasserbehilter

& Ziehe den Stecker aus der Steckdose.
1. Lose mit dem Inbusschlissel vom Zubehorsatz die

6-Torx-Schrauben und entferne den hinteren Deckel.




Eine Laserrohre hat zwei Seiten. Die mit dem roten Kabel,
welche ndher am Touchscreen liegt, wird als
Hochspannungsseite bezeichnet und die andere neben dem

ersten Spiegel wird als Niederspannungsseite bezeichnet.

A Hochspannung A Niederspannung

2. Suche den weiBBen Stecker auf der Hochspannungsseite.

Offne den Stecker und ziehe ihn ab.

3. Suche den weiBBen Anschluss in der Néhe der
Niederspannungsseite.
Dricke die Taste am wei3en Anschluss, um das an die
Niederspannung angeschlossene Kabel zu [6sen und zu entfernen



5. Schiebe die Schlauchklemme mit einer Zange von der

Laserréhre weg.




6. Nehme die Laserrdhre aus dem Gehause und halte die

Niederspannungsseite lber einem Behalter.

-
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7. Trenne den Schlauch von der Laserréhre und lasse das

Wasser ab.Verstopfe den Schlauch wenn Du fertig bist.




8. Lege ein Handtuch in die Hochspannungsseite.

9. Schneide den Kabelbinder am Schlauchende mit

einem Seitenschneider oder einer Schere ab.




10. Ziehe den Schlauch ab und verstopfe das Ende.

Verschiitte kein Wasser in das Gerat. Falls trotzdem Wasser
hinein gelangt, trockne das Wasser und warte, bis die Maschine

vollsténdig getrocknet ist, bevor Du den Betrieb aufnimmst.

11. Die Laserrohre ist jetzt vollstandig abgeklemmt und kann

aus der Maschine entfernt werden.




12. Setze die neue Laserrohre ein und verbinde die Schlauche

an beiden Enden.

13. Ziehe die Hochspannungsseite mit einem Kabelbinder fest
und klemme das andere Ende mit der originalen

Metall-Schlauchklemme fest.

A Ziehe die Hochspannungsseite mit einem
Kabelbinder fest



A Die Niederspannungsseite mit der Metall-Schlauchklemme
festklemmen

& Lose die Metallklemme langsam und lasse sie nicht spicken,

sonst konnte die Laserrdhre beschadigt werden.

14. SchlieBe den weiBen Stecker auf der Hochspannungsseite
wieder an. Stecke das Kabel in die Klemme auf der
Niederspannungsseite und stelle sicher, dass das Kabel
festgeklemmt ist und nicht herunterfallt. Uberpriife, ob das

Kabel fest an der Klemme festgeklemmt ist.




A Uberpriife, ob das Kabel fest an der Klemme
festgeklemmt ist

14. Setze das Rohr in das Geh&use ein. Stelle sicher, dass an
beiden Enden Platz vorhanden ist. Der Anschluss an der
Réhre, der mit dem dicken roten Kabel verbunden ist, sollte
nach innen zeigen. Montiere die Schrauben des

Rohrhalterclips und stelle sicher, dass das Rohr fest sitzt.

& Stelle sicher, dass der Anschluss des roten Kabels nach innen
zeigt und nicht in eine andere Richtung. Lasse das Kabel
nicht das Rohrende beriihren oder nahe an der Seite des
Gehauses liegen. Eine falsche Platzierung der Réhre kann zu
Spannungslecks fihren.




15. Stelle sicher, dass alles richtig installiert ist. Schalte die

Maschine ein, wenn Du bereit bist.

& Beriihre nicht den Bereich der Hochspannungsseite der Réhre,

um einen elektrischen Schlag zu vermeiden!

16. Driicke "Maintain" und der Laserkopf geht in die
Ausgangsposition. Driicke "pump" und das Kiihlwasser wird

in die Laserrohre gepumpt.

& Achte darauf, nicht "laser" zu driicken. Halte die Finger nicht in

die Nahe des Laserstrahlauslasses.

17. Ziehe den Netzstecker und offne den Deckel des Wassertanks
mit dem kleinen Gabelschlissel. Fille den Tank mit

destilliertem Wasser mit dem Trichter und verschlieRe den

Wassertank wieder.




A Offne den Tank mit dem kleinen Gabelschliissel

18. Wiederhole die Schritte 11 und 12, bis der
Tankfullstand nicht mehr sinkt. Dann ist der Austausch

abgeschlossen.
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7.1 KEIN LASERSTRAHL

Wenn bei laufendem Beamo kein Laserstrahl ausgegeben
wird und ein lautes Knacken zu héren ist, weist dies darauf
hin, dass die Rohre gebrochen ist. Bitte stelle den Betrieb
des Gerats ein, um weitere Schaden zu vermeiden.

Wenn Du kein Knacken hdorst, Uberpriife bitte Folgendes:

1. Wahle am Touchscreen> Maintain, stelle sicher, dass die
“power” auf "x1.0" eingestellt ist, und schlieBe dann den
Deckel. Driicke auf ,Laserpuls” und beobachte im
Laser-Beobachtungsfenster, ob ein rosa fluoreszierendes
Licht emittiert wird. Wenn ja, bedeutet dies, dass die
Laserréhre funktioniert. Uberpriife den optischen Pfad. Wenn

kein rosa fluoreszierendes Licht beobachtet wird, wende dich

bitte an den FLUX-Support.




7.2 SCHNITT GEHT NICHT DURCH DAS MATERIAL

1.

Wahle am Touchscreen> Maintain, stelle sicher, dass die
“power” auf "x1.0" eingestellt ist.

Uberpriife, ob der Fokus auf die richtige Héhe eingestellt ist.
Uberpriife, ob die Linse oder die Spiegel verschmutzt oder
beschadigt sind.

Uberpriife, ob der optische Pfad ausgerichtet ist.

Wenn der Laser trotzdem nicht durchschneidet, wende Dich bitte

an den FLUX-Support.

7.3 #900 COOLER OFF

Wenn auf dem Touchscreen das Dialogfeld "# 900 Cooler
Off" angezeigt wird, klicke auf "Continue". Wenn die
Fehlermeldung nicht innerhalb einer Minute erneut
angezeigt wurde, sollte das Gerét normal funktionieren.

Uberpriife, ob der Wasserstand des Kiihltanks mindestens

halb voll ist.




7.4 #901 DOOR OPENED

A Wenn die Basis abgenommen ist, installiere die Basis zuerst
wieder.

1. Wahle am Touchscreen > Maintain, achte auf das Symbol in
der oberen rechten Ecke. Uberpriife, ob das Tiirsymbol beim
SchlieBen des Deckels auf ,,geschlossen” gedndert wird.
Wenn das Symbol gedndert wird, sollte das Gerét normal

funktionieren.

BB . b lel offen I : Deckel geschlossen
2. Wenn sich das Symbol nicht andert, liberpriife, ob der

Tirmagnet abgefallen ist.

3. Wenn der Magnet noch vorhanden ist, 6ffne den hinteren
Deckel, nehme einen Magneten und platziere ihn lber dem

Sensor.




7.5 #902 OVERHEATED

1. Die Raumtemperatur sollte 5 - 35°C (41 - 95°F) sein.

2. Wahle am Touchscreen > Maintain, prife ob die
temperatur 5- 35°C (41 - 95°F) betragt.

3. Wenn zwischen der Raumtemperatur und der auf dem
Touchscreen angezeigten Temperatur ein groBBer

Unterschied besteht, wende dich an den FLUX-Support.

7.6 DER LASERKOPF KOMMT NICHT NACH
LINKS HINTEN ZURUCK

1. Bewege den Laserkopf vorsichtig in die Mitte des Bettes.

2. Wahle am Touchscreen > Maintain, Der Laserkopf sollte

sich zuerst nach hinten und dann nach links bewegen.

3. Wenn der Laserkopf nicht in die hintere linke Ecke zurlickkehrt



Verwende Dein Telefon oder Deine Kamera, um ein Video mit dem
gesamten Arbeitsbereich zu erstellen (wie das Bild in Schritt 1).

4. Starte mit dem Filmen und wiederhole Schritt 1 und 2.

Sende das Video an FLUX Support.

7.7 KALIBRIEREN DER KAMERA

1. Offne die Kamerakalibrierung im Beam Studio aus > Menu
> Machines > Choose Machine > Calibrate Camera. Stelle
sicher, dass der Fokus richtig eingestellt ist.

2. Vergleiche das rot gepunktete Quadrat mit dem tatséchlich
gravierten Quadrat und passen Sie die Werte manuell an, damit

sich die beiden Quadrate Uberlappen.

7.8 KAMERAVORSCHAU IST ZU LANGSAM

Das Vorschau Ergebnis besteht aus Fotos, die beim Laden
zusammengestellt werden.Ist die Geschwindigkeit sehr

langsam, versuche, die Internetverbindung zu verbessern.

1. Wahle im Beam Studio > Menu > Machines > Test Network

Settings.



2. Fille die Spalte IP-Adresse des Zielgerats mit der

IP-Adresse vom Beamo aus



3. Drlcke Start und der Test wird gestartet.

4. Wenn die durchschnittliche Antwortzeit mehr als 100 ms
betragt, versuche den Abstand zwischen dem Computer
und dem Router oder mobilen Hotspot zu verringern,

oder versuche es mit einem Netzwerkkabel (Ethernet).

7.9 KAMERAVORSCHAU FUNKTIONIERT NICHT

Wenn die Kameravorschau nicht aktiviert werden kann, versuche

Folgendes:

1. Starte die Maschine neu, wahle "Maintain" und warte, bis
der Laserkopf in die Ausgangsposition geht.

2. Bewege den Laserkopf in die Mitte des Arbeitsplatzes.

3. Wahle “Snapshot”. Wenn das Bild angezeigt wird, bedeutet
dies, dass die Kamera funktioniert. Weitere Informationen
findest Du unter 7.8 Die Vorschau der Kamera ist zu
langsam.

4. Wenn ein Fragezeichen angezeigt wird, bedeutet dies, dass
die Kamera nicht funktioniert. Bitte wende dich an den FLUX

Support.



7.10 VERBINDUNGSPROBLEME

Kein Wi-Fi gefunden

1. Prife, dass der Wi-Fi-Dongle richtig angeschlossen ist.

2. Wenn auf dem Touchscreen keine MAC-Adresse des
drahtlosen Netzwerks vorhanden ist, wende dich an den

FLUX-Support.



Mit dem gewahlten Wi-Fi kann keine Verbindung
hergestellt werden

1.

Der Wi-Fi-Verschlisselungsmodus sollte WPA2 oder

kein Kennwort sein.

Der Verschlisselungsmodus kann in der Adminoberflache
des WLAN-Routers eingestellt werden. Wenn der Router

WPAZ2 nicht unterstitzt und Du Hilfe bei der Auswahl des
richtigen Routers bendtigst, wende sich an den

FLUX-Support.

Der Beamo erscheint nicht in der Software

1.

Wahle am Touchscreen > Settings > Internet und
bestatige die IP-Adresse. Wenn die IP-Adresse mit
169.154 beginnt, siche "IP-Adresse beginnt mit 169.154"

(5.94)

Wabhle im Beam Studio > Menu > Beam Studio

> Preferences, und fiille die Spalte Maschinen-IP-Adresse
aus.

Wenn das Gerat nicht angezeigt wird, lese bitte

"Verbindung bestatigen”.

Verbindung bestitigen

Prufe, dass die IP-Adresse des Gerats angezeigt wird und

nicht mit 169.154 beginnt.



Wahle im Beam Studio > Menu > Machines > Test Network

Settings

L B SO e o e L S s S

Fille die Spalte IP-Adresse des Zielgerats mit der

IP-Adresse des Gerats aus.
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3. Dricke Start und der Test wird gestartet.

- hletwork Testing
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Die Antwort entahaltet Netzwerkgesundheit und
durchschnittliche Antwortzeit. Die Netzwerkgesundheit sollte
> 95% betragen, die durchschnittliche Antwortzeit sollte
<100 ms sein.

Wenn die IP-Adresse des Gerats eingegeben wurde, das
Gerat jedoch immer noch nicht gefunden wird, aktualisiere
die Software auf die neueste Version. Wenn das
Verbindungsproblem weiterhin besteht, wende dich bitte an
den FLUX-Support.

0 | Test Completed

|| bstwork Hesithiness : 85 5
K || Awerags Feeponse Timec: 157 s




IP-Adresse beginnt mit 169.154

1. Wenn die IP-Adresse mit 169.154 beginnt, sollte es sich um
ein  DHCP-Einstellungsproblem handeln. Wende dich an
Deinen ISP (Internetdienstanbieter), um weitere
Unterstltzung zu erhalten.

2. Wenn |hr Computer Uber PPPoE eine direkte Verbindung
zum Internet herstellt, wechsel zur Verwendung des Routers,
um eine Verbindung Uber PPPoE herzustellen, und aktiviere

die DHCP-Funktion im Router.

7.11 SOFTWARE BEENDET UNERWARTET

e  Windows

Bei plotzlichen Programmabstiirzen, installiere die neueste
"Visual C ++ Redistributable 2015 - 2019" von Aktuelle

unterstutzte Downloads fur Visual C++ fur dein 32bit- bzw.

64bit System, dies kannst du unter
"Systemsteuerung\System und Sicherheit\System"
Uberpriifen. Dort ist auch ersichtlich falls ein Windows 7
ohne ServicePack 1 (SP1) installiert ist. Das Windows

Update KB2670838 ( Download Plattformupdate fiir

Windows 7 from Official Microsoft Download Center)

aktualisiert darauf, danach sollte noch ein aktueller

Grafiktreiber installiert werden.


https://support.microsoft.com/de-ch/help/2977003/the-latest-supported-visual-c-downloads
https://support.microsoft.com/de-ch/help/2977003/the-latest-supported-visual-c-downloads
https://www.microsoft.com/de-ch/download/details.aspx?id=36805
https://www.microsoft.com/de-ch/download/details.aspx?id=36805

macOS

Aktualisiere Dein Betriebssystem auf mac OS 10.14
(Mojave) oder hoher. Frilhere Betriebssystemversionen

weisen moglicherweise Kompatibilitatsprobleme auf.

Linux

Wegen zahlreicher Systemen stelle das Softwareprotokoll

bitte dem FLUX-Support zur Verfligung






8.1 TECHNISCHE DATEN

Abmessungen

615 x 445 x 177 mm (24.2 x 17.5 x 6.9 inches)
Gewicht 22 kg (48.5 pounds)

Mechanisches

Arbeitsflache 300 x 210 x 45 mm (11.8 x 8.2 x 1.7 inches)
Kamera HD CMOS

Laser

Leistung 30W

Wellenlange 10640 nm

8.2 AUFBEWAHRUNG & TRANSPORT

Bitte bewahre die Originalverpackung und -polsterung auf.

e Wenn lhr Beamo fur kurze Zeit nicht verwendet wird,
empfehlen wir, ihn abzudecken, um ihn vor Staub und
anderen Verschmutzungen zu schitzen.

e Um lhren Beamo Uber einen langeren Zeitraum zu lagern,
muss er in der Originalverpackung verpackt sein und darf
keinen hohen Temperatur- und Feuchtigkeitsschwankungen

ausgesetzt werden.



Der Beamo muss in der Originalverpackung transportiert
und versendet werden. Beamo darf nicht geworfen,
geschlagen, geschiittelt oder anderen mechanischen

Belastungen ausgesetzt werden



8.3 FLUX SUPPORT

Wenn Du Hilfe bei der Lésung eines Problems bendtigst, wende
sich per E-Mail an den FLUX-Support: support@flux3dp.com.
Bitte lese das Benutzerhandbuch vollstandig durch und
installiere die neueste Software und Firmware, bevor Du dich an

den Kundendienst wendest.

8.4 DEMONTAGE & ENTSORGUNG

Der Beamo kann als komplettes Gerat entsorgt werden. Du
musst das Geréat vor der Entsorgung nicht zerlegen. Nur die
Kabel und Liftungsschlduche kénnen separat von lhrem Beamo
an die Sammelstelle fir elektrische Geréate tbergeben werden.
Wenn eine Demontage des Gerats erforderlich ist, wende dich
bitte an den FLUX-Support. Wie in 1.3 Sicherheit und
Laserklasse beschrieben, ist der Benutzer nicht dazu bestimmt

den Beamo zu zerlegen.

Entsorgung, Umweltaspekte

Der Beamo darf nicht gemalB den ortlichen Gesetzen und
Vorschriften mit Hausmll entsorgt werden. Dein Beamo ist ein
elektronisches Gerat und muss gemal3 der Abfallrichtlinie fur

elektrische und elektronische Gerate Deines Landes an den



ortlichen Abfallsammelstellen flr elektrische und elektronische
Gerate entsorgt werden. Bei weiteren Fragen wende Dich

bitte an FLUX.



